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A. What is CellDesignerTM
CellDesigner is a process diagram editor for drawing gene-regulatory and biochemical networks.
Networks are drawn based on the process diagram, with graphical notation system proposed by
Kitano, and are stored using the Systems Biology Markup Language (SBML), a standard for
representing models of biochemical and gene-regulatory networks. Networks are able to link with
simulation and other analysis packages through Systems Biology Workbench (SBW).
HU

HU

UH

UH

HU

U

UH

CellDesigner = SBML + SBGN + Simulation + Databases Connections
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1. CellDesigner Major Features











Easy-to-understand graphical notation (SBGN compatible)
SBML-compliant
Built-in simulator (SBML ODE Solver, Copasi)
Integration with analysis tools and other simulators via SBW 2.x
Database connections
Intuitive user interface
Extensive description of Compartments, Species, Reactions, and Proteins
Export of images in PNG, SVG, JPG, and PDF formats
Support of Block Diagram (*Proto-type)
Plug-in development framework

1.1 New Features --- Version 4.4
CellDesigner 4.4.


See also: http://celldesigner.org for details.
H

Major new features and changes in CellDesigner 4.4 are as follows:
 ChEBI support on Database menu
 Plugin API: SBGN-ML export, run Simulation
 Solver selection assistance
CellDesigner now checks a model before running a simulation.
Currently CellDesigner disables SOSlib when:
1. a model contains "delay" csymbol (which will be DDE)
2. a model contains <functionDefinition>
3. a model contains <algebraicRule>
and disables COPASI when:
1. a model contains "Delay" csymbol.
The reason is shown in pop-up message of each radio button.
 Installer update
 Linux 32bit and 64bit support
 Mac OSX (Marvericks) support
 SABIO-RK API connection


See also: Chapter 9.2.3 “To import the reaction information from SABIO-RK database”

 Libraries update
 SBGN-ML library


See also: Chapter 13.4 “Export to SBGN-ML file format

 libSedML library


See also: "To save simulation conditions into files” and “9 Parameter Polymorphism” sections
in “Running CellDesigner Simulation with Control Panel” quick tutorial.

 SimulationCore library
 DBGET link update
 Sample files update
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2. CellDesigner and SBML
SBML (Systems Biology Markup
Language) is a machine readable
format (XML) for representing
computational models in systems
biology. Over 100 software
packages now support SBML. Its
focus is to describe the systems of
biochemical reactions. Models can
also include compartments, events,
rules and constraints.
CellDesigner can read/write in
SBML format with rich enhanced
functions stored as SBML annotations.

For details of SBML, please refer to http://sbml.org website.
HU

UH

SBML format
<?xml version=”1.0” encoding=”UTF-8”?>
<sbml xmlns=”http://www.sbml.org/sbml/level1” level=”2” version=”4”>
<model name=”ATitle”>
<listOfCompartments>
<listOfSpecies>
</listOfSpecies>
</listOfCompartments>
</model>
</sbml>
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3. CellDesigner and Graphical Notation
CellDesigner supports graphical notation and listing of the symbols based on proposal by Kitano
and adopting the most of SBGN (=Systeme Biology Graphical Notation) Process Diagram Level 1.1
notations..
H

H

SBGN (Systems Biology Graphical Notation) (http://sbgn.org) is a graphical notation for
representing biological interactions, such as protein-protein interactions and gene regulatory
networks. Current discussions on SBGN focus on three graphical notations: process diagram, entity
relationship diagram and activity flow. CellDesigner adopts the process diagram as its graphical
notation.
HU

Pure SBML without notation

UH

SBML with notation

CellDesigner Ver. 4.2 introduced new notation called “Reduced Notation”. The following notations,
which can be connected with Species, have been added:
 Positive Influence
 Negative Influence
 Reduced Stimulation
 Reduced Modulation
 Reduced Trigger
 Unknown Positive Influence
 Unknown Negative Influence
 Unknown Reduced Stimulation
 Unknown Reduced Modulation
 Unknown Reduced Trigger
These notations can be connected with other Reduced
Notations.
Boolean logic gate can be connected with these notations.
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Reaction, Add reactant, and Add product are not allowed to connect with Reduced Notation.


See also: “Appendix 1.1.9 Reduced Notation”

Glyphs used in the graphical notation of CellDesigner


See also: “Appendix 1 Symbols and Expressions” for details on CellDesigner graphical
notation
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B. Startup Guide
1. Installation and Startup
1.1 Operating Environment
1.1.1

OS

 Windows (Vista or later) 32bit only
 Mac OS X (10.6 or later) 32bit, 64bit
 Linux with X Window System (Fedora Core 4 or later is recommended)
On Linux platform, due to the version of native libraries, Fedora Core 4 or later is recommended;
some problems will arise if you use other than these.
For 64bit Windows Users, CellDesigner supports 32bit only. Please install CellDesigner onto 32bit
mode.
1.1.2

Java

The current version of CellDesigner requires JRE (Java Runtime Environment).
The installer for Windows and u includes JRE (Java Runtime Environment 1.6), so you do not have
to install Java before your installation.
On Mac OS X 10.6 or later, Java 1.6.0 or later is required.
JRE is not included in Mac OS X Mavericks, so CellDesigner will ask you to install JRE (or JDK) on
your system. Please follow the instruction from CellDesigner.

1.2 Install SBW and SBW Modules
If you are interested in time evolving simulation and analysis on biochemical networks, we
recommend you to install the Systems Biology Workbench (SBW) and SBW-powered software before
you install CellDesigner.
Please check http://sys-bio.org/ and download the software from Software Downloads section.
HU

UH

To install SBW and SBW-powered software, follow their installation instructions.
If you would like to use CellDesigner alone right now, you can postpone this step until you need
simulation and/or analysis.


Note: For details on SBW information, go to
http://sys-bio.org/research/sbwIntro.htm

1.3 Install CellDesigner
The current release is distributed in archived installer package for each operating system.
Windows:
Mac OS X:
Linux:

CellDesigner-44-windows-installer.exe
CellDesigner-4.4-osx-installer.dmg
CellDesigner-4.4-linux-installer.bin

While J2RE is required for CellDesigner to run, the installers include it. Therefore, you do not need
to download or install J2RE.
1.3.1

Windows
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1. Double click CellDesigner-44-windows-installer.exe.
The installer window should open, and follow the message therein.
2. Follow the instruction of the installer.
1.3.2

Mac OS X
1. Double click CellDesigner-4.4-osx-installer.dmg.
The .dmg file should automatically be mounted and a Finder window should open in which
CellDesigner-4.4-osx-installer exists.
2. Then double click it
3. The installer window should open, and follow the message therein.

1.3.3

Linux
1. Open a shell and, cd to the directory where you downloaded the installer.
2. At the prompt, type,
% chmod u+x CellDesigner-4.4-linux-installer.run
% ./CellDesigner-4.4-linux-installer.run

The installer window should open, and follow the message therein.


Note: In case you have installed SBW 2.7.6 or later, and you encounter an error while installing CellDesigner,
there might be a possibility that the C++ Broker is up which prevents CellDesigner to start. Please try to kill the
broker using the Task Manager, or restart your system before you resume the CellDesigner installation.

1.4 Installed File Images
After installation is finished, you would see the following directories/files in the installation
directory (/CellDesigner4.4 by default).
+00README.txt
|

+CellDesigner4.4.exe
executable application module (* Windows only)
+CellDesigner4.4.sh
executable application module (* Linux only)
+CellDesigner4.4
executable application module (* Mac OS X only)
|
+/documents
| +ControlPanel44.pdf
quick tutorial for control panel
| +PluginTutorial43.pdf
quick tutorial for plug in
| +StartupGuide44.pdf
this document
| +/plugin
| +index.html
Plug-in API document
|
+/exec
| +autolayout_yobf.jar
| +celldesigner.jar
library for CellDesigner application
| +yObf.jar
|
+/jre (1.6) *(Windows, Linux only)
|
+/lib
| +ant-schematron.jar
| +avalon-framework-4.1.4.jar
| +axis.jar
| +batik.jar
| +browserlauncher.jar
| +collections-generic-4.01.jar
| +Commons-discovery-0.2.jar
| +commons-io-1.4.jar
| +commons-logging-1.0.4.jar
| +commons-math-2.2.jar
| +concurrent.jar
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| +copasi.jar
| +copasi_gui.jar
| +customizer.jar
| +freehep-export-2.0.3.jar
| +freehep-graphics2d-2.0.jar
| +freehep-graphicsio-2.0.jar
| +freehep-graphicsio-ps-2.0.jar
| +freehep-io-2.0.1.jar
| +freehep-swing-2.0.2.jar
| +freehep-util-2.0.1.jar
| +icu4j_3_4,jar
| +iri.jar
| +itext-1.4.6.jar
| +jai_codec.jar
| +jai_core.jar
| +Jakarta-oro.jar
| +jaxen-1.1.1.jar
| +jaxrpc.jar
| +jcommon-1.0.0-pre2.jar
| +jdom-contrib.jar
| +jdom.jar
| +jena.jar
| +jersey-client-1.2.jar
| +jersey-core-1.2.jar
| +jeuclid-2.0.jar
| +jfreechart-1.0.0-pre2.jar
| +jlibsedml.jar
| +jmathml.jar
| +Jmf.jar
| +jsbml-1.0-incl-libs.jar
| +jsr311-api-1.0.jar
| +junit-4.8.jar
| +log4j-1.2.12.jar
| +mediaplayer.jar
| +miglayout-4.0-swing.jar
| +mlibwrapper_jai.jar
| +MRJAdapter.jar
| +multiplayer.jar
| +openide-lookup-1.9-patched-1.0.jar
| +org.sbgn.jar
| +pantherConverter.jar
| +poi-3.0-rc4-20070503.jar
| +quaqua-filechooser-only.jar
| +saaj.jar
| +sabiows.jar
| +SBGN.xsd
| +sbgn_pd.sch
| +sbmlj.jar
| +SBWCore.jar
| +SimulationCoreLibrary_v1.4_slim.jar
| +SOSlib.jar
| +UlmGraph.jar
| +wsdl4j-1.5.1.jar
| +xercesImpl.jar
| +xml-apis.jar
| +xom-1.2.1.jar
|
+CellDesigner4.4.ico
*(Windows only)
+bzip2.dll
*(Windows only)
+CopasiJava.dll
*(Windows only)
13

CellDesignerTM Startup Guide
+libexpat.dll
*(Windows only)
+libsbml.dll
*(Windows only)
+sbmlj.dll
*(Windows only)
+SOSlibJava.dll
*(Windows only)
+zlib.dll
*(Windows only)
|
+libbz2.so.1
*(Linux only)
+libCopasijava.so
*(Linux only)
+libexpat.so.1
*(Linux only)
+libsbml.so
*(Linux only)
+libsbmlj.so
*(Linux only)
+libSOSlibJava.so
*(Linux only)
+libz.so.1
*(Linux only)
|
+libbz2.1.0.dylib
*(Mac OS X only)
+libCopasiJava.jnilib
*(Mac OS X only)
+libexpat.1.dylib
*(Mac OS X only)
+libquaqua64.jnilib
*(Mac OS X only)
+libsbml.dylib
*(Mac OS X only)
+libsbmlj.jnilib
*(Mac OS X only)
+libSOSlibJava.jnilib
*(Mac OS X only)
+libz.1.dylb
*(Mac OS X only)
|
+/licenses
| +/celldesigner
| +license.txt
| +/libraries
| +axis.LICENSE.txt
| +batik.LICENSE.txt
| +batik.NOTICE.txt
| +FreeHEP.LGPL.txt
| +FreeHEP.LICENSE.txt
| +itext-MPL.LICENSE.txt
| +jai.LICENSE.txt
| +jfreechart.LICENSE.txt
| +libsbml.LICENSE.txt
| +mrjadapter.LICENSE.txt
| +quaqua.LICENSE.html
| +xerces.LICENSE.txt
| +xercesImpl.LICENSE.txt
| +xercesImpl.NOTICE.txt
| +xml-apis.LICENSE-SAX.html
| +xml-apis.LICENSE.DOM-documentation.html
| +xml-apis.LICENSE.DOM-software.html
| +xml-apis.LICENSE.txt
| +xml-apis.NOTICE.txt
| +yfiles-3rdPartyLicenses.html
| +yfiles-GeneralLicenseTerms.html
| +yfiles-GeneralTermsandConditions.html
|
+/Microsoft.VC80.CRT
*(Windows only)
| +Microsoft.VC80.CRT.manifest
| +msvcm80.dll
| +msvcp80.dll
| +msvcr80.dll
|
+/patches
*(Mac OS X only)
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| +fixJavaApplicationStub.sh
|
+/plugin
compiled plugin jar files are added in this directory
| +MappingArrayMass_plugin.jar
|
+/samples
| +components44.xml sample for various components
| +database44.xml
sample for database connections
| +M-Phase.xml
sample for model editing
| +M-Phase2.xml
sample for model editing
| +Macros.xml
sample for macros
| +MAPK.xml
sample for simulation provided by SBML ODE Solver
| +MAPK42.xml
sample for simulation provided by SBML ODE Solver
| +SBGNRefCard.xml
| +sim1.xml
| +sim2.xml
| +unitOfInformation.xml
sample for unit of information
| +/nbt
sample files used in Nature Biotech paper by Kitano
| +/notation sample files for notation
| +/plugin
sample source and jar files for plugin
| +/sbml
samples from SBML specifications
|
+ mmlctop2_0.xsl
|
+uninstall.exe
*(Windows only)
+uninstall
*(Linux only)
+Uninstaller
*(Mac OS X only)
+Uninstall CellDesigner4.4 *(Windows, Linux only)
+uninstall.dat
*(Windows, Linux only)

1.5 Startup CellDesigner
1.5.1

Windows
1. Double click the shortcut icon for CellDesigner4.4
in your desktop.
2. Or double click CellDesigner4.4.exe in the directory where you chose to install
(C:/Program Files/CellDesigner4.4 by default).

1.5.2

Mac OS X
1. Double click the CellDesigner4.4 icon
in the folder you chose to install
(/Application/CellDesigner4.4 by default).

1.5.3

Linux
1. On a shell, type ./runCellDesigner4.4 in your home directory.
2. Or type ./runCellDesigner4.4 after changing to the directory where you chose to install
(CellDesigner4.4 in your home directory by default).
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1.6 CellDesigner User Interface and Navigation
CellDesigner consists of Menu, Toolbar, and the five areas as shown below

Menu
Toolbars

Draw Area

Tree Area

Layer Area
List Area

1.6.1

Notes Area

Draw Area:

To draw a model

List Area:

To display and edit the list of the components, functions of a model

Notes Area:

To display and edit the notes of the component

Tree Area:

To display all the list of the components in the tree structure.

Layer Area

To display all the layers of the model.

To change the size of each Area
1. The size of the areas can be changed by dragging the borderlines.
2. To maximize the area, click the triangle icons on the borders.
(See the orange circles in the above screen.)

1.6.2

To change the position of List and Notes Areas
1. To switch the display position of the List and Notes Areas,
select View - List menu, then select Right or Down.

1.6.3

To customize Toolbar
1. Each group of the icons can be detached from the Toolbar.
2. It can also be moved to the side (left or right) or the bottom of the main window by dragging
the handle.

1.6.4
1.

To show / hide Toolbar
Select View – Change Toolbar Visible menu, then select the toolbar component you want to
show/hide.
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2. Quick Tutorial of Model Building
This section is for beginners, and describes how to edit a model with CellDesigner in brief.
A sample file “M-Phase.xml” is used in this tutorial since this model contains most of the essential
CellDesigner's expressions of biochemical networks.

2.1 Open a Sample Model
1. Select File - Open in the Menu to open M-Phase.xml in the “samples” directory.
2. A graphical network model is displayed on the Draw Area.

3.
4.
5.
6.

In the Menu, select File – Save as… to open the Save dialog.
In the File name text box, enter a new name, e.g. “M-Phase_Test.xml”.
Click Save.
Drag the borders (left or right) of the Draw Area to change the area size.

2.2 Zoom
1. You can change the zoom view of the model by clicking the following icons.

2.3 Select a Component
A component is a general term for a Species (including a Complex), a Reaction, or a Compartment.
Thus, any shape you see on the Draw Area ---a rectangle, an oval, or a line segment--- is a
component.
2.3.1

To select a Component
1. Confirm that Select Mode icon is highlighted. If not, click the arrow icon.
2. Select a component in the Draw Area. For instance, select the green square-shaped
component labeled “CAK” which you will find in the upper left corner of the Draw Area.
This shape indicates that the component is a Protein.
17
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3. Observe that the green square, a Protein, and also the linked line, called a Reaction, are
highlighted.

2.4 Move / Delete a Component
1. Select a Species (e.g. a Protein) and drag it to see the linked Reactions follow as the Species
moves.
2. Delete the Species by the Delete key, and see the linked Reactions are deleted as well.
3. To undo the deletion, select Edit – Undo in the Menu bar.

2.5 Undo / Redo
You can “undo" the previous actions by Ctrl-Z, and also “redo” after the undo by Ctrl-Y before
saving the model.


2.5.1

For Mac OS X, use Command key instead of Ctrl key.

To undo or redo the previous action
1. Undo by Ctrl-Z.
2. Redo by Ctrl-Y.

2.6 Change the Size of a component
1. When you select a Species or a Reaction, you will find small squares on it. These are the
handles to change their size or to bend the line of the Reaction.
2. Select one of the small squares and drag it.

2.7 Compartment
The shape with a thick (and yellow by default) border line is called a Compartment.
A Compartment is a container for other components and can also hold other Compartments in it. A
Compartment represents a generic bounded container, such as a cell or an intracellular
compartment. The change in its size and shape only affects its appearance on canvas, and has no
effect on semantics of biochemical and gene networks.
2.7.1

To put components in a Compartment
1. To select a Compartment, click on its border line.
2. See the edge of the border line is turned into magenta and the Species inside are shadowed.
3. A Compartment can hold Species and other Compartments inside.
4. Drag the Compartment, and confirm that the Species inside follow it.

2.7.2

To change the shape of a Compartment
1.
2.
3.
4.

Select a Compartment.
In the Menu, select Component – Change to OVAL.
Observe the shape has changed to an oval.
Select the Compartment again.
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5. In the Menu, select Component – Change to SQUARE and observe the shape has changed
to a square.
2.7.3

To change the position of the Compartment name
1. Find the Compartment name which is initially located at the bottom of the Compartment.


Note: In the M-Phase_Test.xml sample model, you will find “cell” as the Compartment name.

2. Select the Compartment name, drag and drop it wherever you want.

2.8 Species and Reactions
A Species represents, for example, a
protein or some other molecule in a
biochemical network, or a gene in a gene
regulatory network.
A Reaction represents a state transition of
the connected Species such as a
biochemical reaction, an interaction
between proteins, and a regulatory
relation between genes.
The biochemical and genetic meanings of
Species and Reactions are distinguished
by their symbols. The list of all symbols
that can be drawn using CellDesigner and
their meanings are described in
“Appendix 1: Symbols and Expressions”.
2.8.1

To change the symbol of a Species

If you double click a Species or a Reaction, a dialog box will appear to alter its properties.
1. Double click a Species, for example, “CAK”, then the Change identity of the species dialog
box will be displayed.

2. Change the value in the class drop-down menu. You can switch from Protein to Gene, RNA,
Ion, etc., and vice versa.
3. If necessary, enter a name the name text box.
4. Click Apply button and see the shape has been changed.
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2.8.2

To change the symbols of Reactions
1. Double click a Reaction.

2. Change values in the dialog box, and see what have been changed after clicking OK button.

2.9 Activate a Species
2.9.1

To activate a Species
1. Select a Species.
2. Type “a” on keyboard.
Or, select Component – Set Active in the Menu.
3. See the Species is wrapped by a dashed line.


Note: The dashed line has a somewhat ambiguous meaning, indicating only that the Species is “active”
without referring to its targets.



See also: “Appendix 1.1 Basic Symbols”

2.10 Close a Model
2.10.1

To close a file without saving any changes.

1. Select File – Close.

2.11 Create a New Model
2.11.1

To create a New Model

1. Select File - New menu or press Ctrl-N.
The New Document dialog will display.
2. Specify Name, Width, and Height of a new model.
3. Click OK.


Note: For Mac OS X, use Command key instead of Ctrl key.



Note: The Name you specify here will be not only the file name but the model id in the xml file when you select
File – Save in the Menu. Therefore, the Name needs to conform to SBML convention.
e.g. If you specify “sample” here, the file name will be “sample.xml”, in which <model id="sample"> is
written.
However, if you select File – Save As … in the Menu, you can give a file name different from the model id in the
xml file.
e.g. If you save as “sam ple”, the file name will be “sam ple.xml” but the model id is still <model
id="sample">. See the file name has a space in it but the model id does not.



Note: Naming Convention
The model id only accepts the Type Sid defined in SBML specification as follows:
letter ::= ’a’..’z’,’A’..’Z’
digit ::= ’0’..’9’
idChar ::= letter | digit | ’_’
SId ::= ( letter | ’ ’ ) idChar*



See also: Systems Biology Markup Language (SBML) Level 2: Structures and Facilities for
Model Definitions
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2.12 Create a New Compartment, Species and Reactions
If you want to create a new Species, Reaction, or Compartment, use icons on the tool bar.

2.12.1

See also: “Appendix 1 Symbols and Expressions”
To create a new Compartment

1. Select an icon from the Compartment tool bar (as shown below).
2. Place your cursor anywhere on the Draw Area to make a Compartment of your favorite
size.
3. In the Property of compartment dialog, specify its Name and Size.


Note: The size may be a volume (if the compartment is a three-dimensional one), or it may be an area (if the
compartment is two-dimensional), or a length (if the compartment is one-dimensional).



See also: Systems Biology Markup Language (SBML) Level 2: Structures and Facilities for
Model Definitions, “4.7 Compartments”

2.12.2

To create a new Species

1. Click and select an icon from the Species tool bar (as shown below).
2. Click anywhere on the Draw Area where you want to place the new Species.
2.12.3

To create a new Reaction

1. Click on an icon from the Reaction tool bar (as shown below).
For the detail of
each icon, see the following sections.



2.12.4

See also: “Appendix 1.1.6 Reaction (State Transitions and others)”
See also: “Appendix 1.1.7 Reaction (Modifications)”
See also: “Appendix 1.1.8 Reaction (Logical Operations)”
To create a new Reaction - State Transition <One to One type>

1. On the Reaction Toolbar, click one of the following icons. (from left to right)
-State Transition
-Known Transition Omitted
-Unknown Transition
-Transcription
-Translation
-Transport
2. Click a Species as the start-point.
3. Click another Species as the end-point, and see a Reaction line has been drawn.
2.12.5

To create a new Reaction - State Transition <Two to One type>

1. On the Reaction Toolbar,
click the following icon.
-Heterodimer Association
2. Click a Species and then another for start-points.
3. Click a Species for an end-point, and see a merged Reaction line is drawn.
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2.12.6

To create a new Reaction - State Transition < One to Two type >

1. On Reaction tool bar,
click one of the following icons.
-Dissociation
-Truncation
2. Click a Species for a start-point.
3. Click a Species and then another for end-points, and see a forked Reaction line is drawn.
2.12.7

To create a new Reaction - Add Reactant

1. On Reaction tool bar,
click the Add Reactant icon.
2. Click a Species to start at.
3. Place the cursor on a Reaction and find a blue point.
4. Click on it, and see a Reaction line is drawn.
2.12.8

To create a new Reaction - Add Product

1. On Reaction tool bar,
click the Add Product icon.
2. Place the cursor on a Reaction and find a blue point.
3. Click on it.

4. Click a Species to end at, and see a Reaction line is drawn.
2.12.9

To create a new Reaction - Modification

1. On the Reaction Toolbar, click one of the following icons,
-Catalysis
-Unknown Catalysis
-Inhibition
-Unknown Inhibition
-Physical Stimulation
-Modulation
-Trigger
2. Click a Species for a start-point.
3. Click a square (“process node”) on a Reaction for an end-point, and see a Reaction line is
drawn.
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Note: You can connect Modification arc to Species “Phenotype” directly.

2.12.10 To create a Homodimer/ degradation / tag
There are some icons with actions not mentioned above. Try the followings after selecting the icons
and see what happens.
1. To create a Homodimer Formation, click the Homodimer Formation icon
target Species.
2. To create a Degradation, click the Degradation icon
3. To create a Tag, click the Auto Create Tag icon

, then click a target Species..

, then click a target Species.

2.12.11 To create a Boolean logic gates
1. Draw two Species and connect them with a Reaction (State Transition).

2. Or equivalently, on the Toolbar, select the State Transition macro icon
and then click anywhere on the Draw Area.
3. Draw two more Species.
4. On the tool bar, click one of the icons below.
Select the two Species painted last.
5. Then click a square (“process node”) on the Reaction (State
Transition), and see a Reaction line is drawn.


See also: “Appendix 1.1.8 Reaction (Logical Operations)”

2.12.12 To create a new Reaction – Reduced Notation (New to Ver.4.2)
1. The Reduced Notation Toolbar is hidden as default.
To show the toolbar, select View – Change Toolbar
Visible menu to set it visible.
2. On the Reduced Notation Toolbar, click one of the
following icons,
Positive Influence
Negative Influence
Reduced Stimulation
Reduced Modulation
Reduced Trigger
Unknown Positive Influence
Unknown Negative Influence
Unknown Reduced Stimulation
Unknown Reduced Modulation
Unknown Reduced Trigger
3. Click a Species for a start-point.
4. Click another Species.
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2.12.13

To create a new Reaction – Reaction on Reaction Reduced Notation

These notations can be connected with other Reduced
Notations.
1. On the Reduced Notation Toolbar, click one of
the following icons,
Positive Influence
Negative Influence
Reduced Stimulation
Reduced Modulation
Reduced Trigger
Unknown Positive Influence
Unknown Negative Influence
Unknown Reduced Stimulation
Unknown Reduced Modulation
Unknown Reduced Trigger
2. Click a Species for a start-point.
3. When you float over the center of another Reduced Notation, a square (“process node”) pops
up.
4. Click the point where it pops up.
2.12.14 To use Boolean Logic gate with Reduced Notation Reaction
Boolean logic gate can be connected with these notations.



Note: A Reduced Notation cannot be connected to a standard Reaction, such as a State Transition. The
reverse is also true, a standard Reaction cannot be connected to a Reduced Notation.

2.13 Create a Complex
2.13.1

To create a Complex

1. Click the Complex icon on the Toolbar.
2. Move the cursor onto the Draw Area and click the left mouse button to place a Complex.
3. In the Name of the species dialog box, enter a name of your choice. The name can be a
simple name as well as a long name which includes the names of the species contained in
the Complex, e.g. “Complex(ProteinA, ProteinB, ProteinC)”.
4. To place Species in the Complex, just drag and drop them into the Complex.
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2.13.2

To modify the Species within a Complex

You can modify the individual Species inside a Complex box at any time. For example, you can add a
residue, change the residue status, or change the name or the class of the Species.


Note: The Notes information of the individual Species will be maintained even though you move the Species
in and out of the complex box.



See also: “5 Species---Protein, Gene, RNA and asRNA”
X

X

X

X

2.14 Complexes and Reactions
A Reaction can be connected to a Complex or to an individual Species/Reaction inside the Complex.
Thus, you can distinguish if the activation is initiated by the Complex, or by an individual Species
inside the Complex.
2.14.1
1.
2.
3.
4.

To change the appearance of a Complex
Select a Complex and type “C” to make it compact.
Type the “C” key again to have the border line invisible. (no border)
Type the “C” key again to get back to the original shape.
You can do the same steps as above by selecting Component - Change Complex View menu.

“normal”

“compact”



Note: You can set a Complex to be displayed with no border. This option is useful when you create a Complex
with Gene/RNA/Antisense RNA inside. Below is an example which you can find in Complex42.xml in
/samples/notation folder.



Note: A Complex can be contained within another Complex. Below is an example which you can find in
components4.xml in /samples folder.

a normal Complex

a compacted
Complex

a Complex (the blue box) contained
in another Complex
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2.15 Macros
To draw the diagram easier, some of the most frequently used components sets are available as
“macros”. You can select the macros from the tool bar to draw the following components set.



See also: “6.12 Macros”

2.16 Edit Reactions
2.16.1

To change connection points of Reaction on Species

A Reaction can be connected to one of the 16 connection points around a Species.
1. Select a Reaction and try to change the connection point.

2.16.2

To add Anchor points

You can add and remove Anchor points by the right click
menu.
1. Click a point on a Reaction where you want to
add an anchor.
2. Click the right mouse button and select Add
Anchor Point.
3. See a new anchor point has been added.

4. To remove the anchor point, click the right
mouse button on the target anchor, and then select Remove Anchor Point.
2.16.3

To move a Species with a Reaction

1. Select a Species with a Reaction attached,
2. Move it around and see the last segment of the Reaction follow the Species.

2.16.4

To change the shape of a Reaction line segment

1. Select a Reaction
2. Click the right mouse button and select To Orthogonal or To Polyline.

Orthogonal

Polyline
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2.16.5

To adjust a Reaction line automatically

1. Select a Reaction which has already been set To Orthogonal.

2. Right-click your mouse and select Adjust Connection in the menu.

2.16.6

To change line width and color setting of a Reaction

1. Select a Reaction.
2. Right-click on it and select Change Color & Shape…
3. Change the color and line width.


2.16.7

from the context menu.

Note: The color and line width of Species and Compartments can be changed in the same way.

To make a reversible Reaction

1. To make a Reaction reversible, double-click the Reaction
2. On the Change property of the reaction dialog box, set Reversible option to True.

2.17 Change Color and Shape of Components
You can change the color and shape of a component individually or collectively.
2.17.1

To change the default settings of the color and shape

1. In the Menu, select Preference – Components Color & Shape.
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2. Click the icon of the component whose color or shape you want to change.
2.17.2

To change the color and shape of the individual components

1. Select the component(s) to edit, and then click the icon of
(Change Color & Shape) in
the tool bar.
2. In the Change color and shape dialog box, change the values as you like.

2.18 Export Image
2.18.1

To export the model image in PNG, JPEG, EPS, SVG or PDF format

1. Select File – Export Image… on the Menu bar.
2. Specify the name and the file format.


Note: The image saved here is the same as the one displayed on the screen.

2.19 Add Model Description
Before you save your model, you can add the description / MIRIAM information to the model.
2.19.1

To add Model Description

1. Select Component – Model Description menu.
The Model Description dialog will display.
2. Specify Creator information, File information to a new model.


For adding MIRIAM information, see also “8 Notes and MIRIAM annotation”.

2.20 Save a Model
CellDesigner stores all the information on the model you create to an SBML format file.
2.20.1

To save a model

1. Select File – Save or Save As….


2.20.2

Note: CellDesigner's specific functions will be stored under <annotation> tag in the SBML file.

To save a model in a pure SBML format

1. Select File - Export Pure SBML Level x Version x….


Note: Naming Convention
The Model ID or/and the File Name only accept the following characters:
(_|[a-z]|[A-Z])(_|[a-z]|[A-Z]|[0-9])*. No blank space is accepted.
This is the SBML convention.
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2.21 Import a Model
2.21.1

To import an SBML file:

1. Select File - Open.
2. In the Open dialog, select a .sbml or .xml file.
3. Click Open.

2.22 Export a Model
CellDesigner supports export the model to SBML (.xml).
2.22.1

To export a model to a pure SBML file (.sbml, .xml)

1. In the Menu, select File - Export Pure SBML Level x Version x….
2. Save dialog opens. Specify a file name and Click Save.


See also: http://sbml.org/ for more details on SBML Levels.
HU

UH

CellDesigner’s file format and pure SBML file format:
CellDesigner stores all information in a SBML file format. While pure SBML format
does not support layout information, CellDesigner stores layout information inside
<annotations> tags in SBML, which is CellDesigner specific extension.
When you export the model into “pure” SBML document, the exported SBML file doesn't
contain any layout information. You may use this feature if you find any trouble when you
tried to open your SBML document with other SBML compliant software.
2.22.2

To export a model to a BioPAX format file (.owl) (change in Ver4.2)

There is a plugin to export BioPAX format file (.owl). Please install the plugin if you wish to convert
CellDesigner model to BioPAX format file.



See also: http://www.celldesigner.org/plugins for mode details on CellDesigner plugins.
See also: http://www.biopax.org for more details on BioPAX levels.
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2.23 Open an SBML File
You can open an SBML file with CellDesigner.
When you retrieve an SBML file created by some other tool than CellDesigner without any layout
information, it will automatically adjust the layout of the model with the layout schemes.

2.23.1

See also: “6.13 Automatic Layout”
To open an SBML file:

1. Select File - Open, then specify the target SBML file.


Note: You can also import the SBML models from BioModels.net database. (http://biomodels.net)



See also: “9 Connect to External Databases”

HU

X

X

UH

X

2.24 Save SBO Terms
The Systems Biology Ontology (http://www.ebi.ac.uk/sbo/) is a set of controlled vocabularies and
ontologies tailored specifically for the kinds of problems being faced in Systems Biology, especially
in the context of computational modeling.
HU

UH

CellDesigner can save the SBO Term automatically.
2.24.1

To save a model with SBO Terms

1. In the Menu, select Edit – SBO Term Value.
2. Check Save with SBO Term Value option.
3. When you save, SBO Terms will automatically be allocated and written in the model file.
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3. Compartments
3.1 Edit a Compartment
The SBML Level 2 Version 4 specification defines a compartment as follows:
“A compartment in SBML represents a bounded space in which species are located. Compartments
do not necessarily have to correspond to actual structures inside or outside of a biological cell,
although models are often designed that way.”


See also:
“Systems Biology Markup Language (SBML) Level 2: Structures and Facilities for Model
Definitions” found in http://sbml.org/Documents/Specifications
HU

3.1.1

U

To edit a Compartment
1. Right click on a Compartment.
2. Select a menu item from the right-click context menu. See the following pictures for detail.

3. Depending on the menu item you have selected, one of the following dialogs will pop up.
4. Change identity of
the compartment
dialog

5. Compartment
dialog
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6. Edit Information
dialog





See also: “Species” section of the CellDesigner.org Online Help
http://celldesigner.org/help/CDH_Species_T.html.
See also: “5 Species---Protein, Gene, RNA and asRNA”
See also: “11 Gene / RNA / AntiSenseRNA Structure Expressions”
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4. Species---General
4.1 Edit Species
A Species is a term defined in the Systems Biology Markup Language (SBML) and represents an
entity in general used in a model. CellDesigner subdivides Species into several categories, i.e.
Complexes, Proteins, Genes, RNAs, or some other Molecules.
4.1.1

To edit a Species
1. Right click on a Species
2. Select a menu item from the right-click context menu.



Note: The fourth menu item (e.g. Edit Protein... in the above figure) is content-dependent. It will only be
displayed if the Species is a Protein, Gene, RNA, or asRNA.

3. Select a menu item depending on which value you want to edit. See the following pictures
for detail.
4. Selecting Change Identity... menu will show you Change Identity of the species dialog.

5. Selecting Edit Information... will show you Edit Information dialog.

33

CellDesignerTM Startup Guide

6. Selecting Edit Species... will show you Species dialog.




4.1.2

See also: “Species” section of the CellDesigner.org Online Help
http://celldesigner.org/help/CDH_Species_T.html.
See also: “5 Species---Protein, Gene, RNA and asRNA”
See also: “11 Gene / RNA / AntiSenseRNA Structure Expressions”
To change font size

1. On the Draw Area, right-click on a Species to show the context menu.
2. Select Change font ....
3. In Change Species Name Font dialog, select a font size.

4.2 Find a Species in the List Area
You can view all the data concerning a Species tab in the List Area. This is useful when you want to
glance over all the Species specified in the model.
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You can swap the column by drag-and-drop.



Note: In the Species list, you will only find a Complex even if the Complex contains other Species. Properties
for the contained Species will appear on other lists correspoding to the Species, and not on the Species list.
For instance, if a Protein is contained in a Complex, its properties will appear on the Proteins list.



Note: In the Species list, the “included” column shows the list of Speices included in a complex. For example,
s1(s2, s3) means the complex s1 includes the Species s2 and s3.

4.3 Export Lists to CSV file
You can export the contents of the list into .CSV file format. All the other lists you can see in the
List Area, such as the Protein list, the Reaction list, can be exported to a CSV file.
4.3.1

To export the list
1. Select the Species tab in the List Area.
2. Click Export button on the list or select File – Export List to CSV… from the menu bar.
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3. The Export Setting dialog will be displayed.

4. In the Export Setting dialog box, check the data properties you want to export, then click
OK.
5. The file name is automatically specified as “xxx.csv” in the Save dialog.
6. Click Save to save the CSV file.


Note: You may use other applications to check the contents of the CSV file.
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5. Species---Protein, Gene, RNA and asRNA
In this section, we shall edit a Protein, Gene, RNA, or asRNA with modification sites. You can use a
sample file “M-Phase2.xml” to go through the following steps.
CellDesigner allows you to add modification residues to a graphical symbol of specific Species types
(Protein/Gene/RNA/asRNA). Hence, you can describe a state transition of a Species in such a way
that two graphical symbols of an identical Species with different modifications are connected by a
Reaction. The structure of modification residues, states, and state transitions of proteins are also
stored in SBML Level 2 format with CellDesigner’s extended tags.
The sample model M-Phase2.xml, which you will find in /samples folder, describes state transition of
“Cdc2,” where there are eight “Cdc2”s. The eight represent different Species, while they are
essentially the same protein. Therefore, CellDesigner should handle data structure describing each
protein in a model, so that several protein-type Species could have references to the same protein
data. This data structure is called “Protein”.


Note: (New in ver. 4.1) In SBML Level 2 Version 4, a new object called “SpeciesType” is being introduced.
SpeciesType is intended to relate the same type of the Species on the model together. This concept
corresponds to the Ids for “Protein”, “Gene”, “RNA” and “asRNA” in CellDesigner.

5.1 Check and Change the Properties on a Protein/Gene/RNA/asRNA
Proteins tab (and also Genes, RNAs, asRNAs tabs) in the List Area shows you all Proteins (Genes,
RNAs, asRNAs) and their properties included in the model.

If you cannot see the Proteins tab in the List Area, click on the right arrow in the upper right corner
of the List Area, and adjust the size of the List Area appropriately.
For an individual Protein, you can view its properties by double-clicking on the Protein row to open
the Protein dialog. In the dialog, you can edit the properties of the Protein, such as name and type,
and also add, edit and delete a residue or a binding region.


5.1.1

Note: Changes in this dialog will be reflected to all Species referring to this Protein, including those inside
Complexes.

To change the type of Protein
1. In the List Area, click Proteins tab.
2. Select “Cdc2” in the list and click Edit button.
Alternatively, you can click one of the “Cdc2” proteins on the Draw Area, click the right
mouse button, and then select Edit Protein… menu item.
3. The Protein dialog will appear.
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4. Select the type of Protein from the drop-down list.
- GENERIC
- RECEPTOR
- ION_CHANNEL
- TRUNCATED

5.2 Residue / Binding Region of a Protein/Gene/RNA/asRNA
In the Protein/Gene/RNA/asRNA dialog, you can add and delete residues and binding regions. You
can also adjust the position of the residues and binding regions in the dialog.



5.2.1

Note: Changes in the modification of residue status (such as phosphorylated, etc.) should be made in the
Change identity of the species dialog.

To add a residue/region to a Protein/Gene/RNA/asRNA
1. On Draw Area, right-click on a Protein, Gene, RNA or asRNA.
2. Select Edit Protein/Gene/RNA/asRNA....
3. Protein/Gene/RNA/AntisenseRNA dialog will appear.

4. Click add or edit button.
5. In the Modification Region dialog (or ModificationResidue / Binding Region dialog when
editing a Protein), specify the name, type, size, and position.
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Note: Name of the dialog is dependent on the Species type.

6. Click Close.
7. In the Protein/Gene/RNA/AntisenseRNA dialog, click Update then Cancel.

5.2.2



Note: You can also delete a residue or a binding region in this dialog.



Note: Changes in this dialog will be reflected to all Species referring to this Protein, including those inside
Complexes.

To specify the modification of a residue

Once you add a residue to a Protein/Gene/RNA/asRNA, you can specify the modification status for a
specific Species. To specify the status per Species, use Change identity of the Species dialog instead of
Protein/Gene/RNA/AntisenseRNA dialog.
1. On the Draw Area, double-click a Protein/Gene/RNA/AntisenseRNA which has a residue.
Or, select Change Identity... from the right-click context menu.
2. Change identity of the species dialog will open.

3. In the dialog, click on the target residue in residues/regions (or regions) diagram in the
middle.
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4. Select a modification type from the modification drop-down list.
Phosphorylated
Palmtoylated
Acetylated
Prenylated
Ubiqutinated
Protonated
Methylated
Sulfated
Hydoxylated
Empty
Glycosylated
Don’t care
Myristoylated
Unknown



Note: You cannot add, edit, or delete modification residues in this Change
identity of the species dialog. To add/ delete a residue, use
Protein/Gene/RNA/AntisenseRNA dialog instead.

5.3 State of a Protein
The state of a Protein can be changed to “open”, “close” or “user defined text”. Here again, you will
use Change identity of the Species dialog instead of Protein dialog.

5.3.1

See also: “2.9 Activate a Species”
To change the state of a Protein

1. Double-click on a Protein to open Change identity of the species dialog.
2. In the state drop-down list, select an option from empty, open, closed or user defined text.

5.4 Add Notes to a Protein, Gene, RNA or asRNA
Protein/Gene/RNA/asRNA Notes allows you to enter additional text information and save it in the
xml file.


Note: Each Protein, Gene, RNA or asRNA has the Species Notes as well as the Protein/Gene/RNA/asRNA
Notes. You should be careful which Notes you want to change when editing.



See also: “8 Notes and MIRIAM annotation”
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5.5 Block Diagram –to check Relationship of a Species (*Proto-type)
Block diagram gives a summary view of interactions with respect to a specific Species (especially
Protein) and relation between its modification and activity as enzyme. Using this block diagram
editor, complex relations between Proteins can be understood at a glance and the relation between
modification states enzymic activity can easily be constructed.


5.5.1

Note: The editor is still a prototype and user interface for edittin is not fully functional.

To extract Regulation

CellDesigner extracts the interactions where the Species regulates or is regulated by other Species,
from process diagram, and displays its block diagram.
1. Open M-Phase.xml.
2. Right click on Species “Cdc2” then select Edit Protein menu.
3. Click edit block diagram button and you can see the diagram as shown below.

At the top side of the rectangle placed in center, states of modification residues of Cdc2 and proteins
that cause change of the states (phosphorylate or dephosphorylate) are shown. At the left and
bottom sides, binding to CyclinB enzymic activity to Lamina are shown respectively.


See also Kitano (Biosilico 1, No.5 (2003) pp.169—176), For notation details of the block
diagram.

List in the dialog shows all the Species of Cdc2 and Complexes with other Species in process
diagram (column) and their modification states and enzymic activity (row).
5.5.2

Modifications/Activations Relation

You can edit logical relation between modification states and enzymic activity.
1. Select the symbol “&” and then place them on the diagram.
2. Select the arrow, and link “P”, “&”, “□” and “■”.
3. To delete a placed symbol, select the symbol and click × in the toolbar.


Note: The arrows represent causal relationship and “&” , “|”, etc. are logical operators. Created logical relation
can also be verified by checking consistency with contents of process diagram.

4. Press verify button.
5. Enzymic activity fields inconsistent with edited logical relation are highlighted in red.
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The above figures, the left is depicted by logical relation inferred by Species s29 only and the
enzymic activity field of Species s28 is highlighted. The right is corrected by using the information
of s28. (Note that the way of correction is not unique.)
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6. Edit a Model
In this section, convenient functions for editing models are introduced.
CellDesigner provides several functions that are generally seen in drawing software.

6.1 Cut, Copy and Paste
6.1.1

To cut and paste a Species
1. Select a Species by clicking on it.

2. On the Edit menu, click Cut. Or type Ctrl-X.
The Species has been cut.
3. On the Edit menu, click Paste.
The Species reappears.
4. In the Notes Area, observe that the Notes content is the same as the original.


6.1.2

Note: For Mac OS X, use Command key instead of Ctrl key.

To copy and paste a Species
1. Select a Species by clicking on it.

2. On the Edit menu, click Copy. Or type Ctrl-C.
3. Paste it on the Draw Area by selecting Edit – Paste, or typing Ctrl-V.
4. In the Notes Area, observe that the Notes content is the same as the original.


6.1.3

Note: For Mac OS X, use Command key instead of Ctrl key.

To change the identity of a Species
1. Right click on one of the Species shown in the previous procedure, and select Change
Identity.
2. If Residues Caution dialog appears, click Close.
The Change identity of the species dialog appears.
3. In the protein list, click New Protein.
4. In the name textbox, type any name, e.g. “mySpecies”. Click Apply.
5. Click No. The name of the Species has been changed to “mySpecies”.
Its id has also been changed but not shown.

6. In the List Area, select Species tab.
See that the id and name of the Species has been changed.

7. In the List Area, select Proteins tab.
See that the id (as a protein) and name of the Species has been changed.
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6.2 SpeciesAlias
The copy-and-paste action makes a duplicate figure of the original Species. The duplicated figure is
called a SpeciesAlias in CellDesigner’s terminology. Strictly speaking, all of the Species on the Draw
Area, including the original Species figure, are SpeciesAliases, each referring to the original Species
object class. In other words, when you have created a new Species, what you see on the Draw Area
is not the Species itself but an Alias of it. This feature enables CellDesigner to have multiple copies
of the same Species object class on the Draw Area, and make various expressions of a network.

6.2.1

To see the relationship between a Species and a SpeciesAlias in XML
1. In the Menu, click File – New to create a new model.
2. Click on any type of Species icon from the Toolbar and place it on the Draw Area.
3. Move the cursor and click anywhere on the Draw Area to place the Species you have chosen.
Now you have a model with only one Species.

4.
5.
6.
7.

Select File – Save as… in the Menu.
Save the file in XML format.
With a text editor, open the XML file you have just saved.
Find the <celldesigner:listOfSpeciesAliases> tag, under which is a child element that
specifies the Alias of the Species. <celldesigner:speciesAlias id="sa1" species="s1">
8. Near the bottom of the XML file, find the <listOfSpecies> tag which lists up all the Species
in your model.
9. Find a tag as below which indicates the Species itself.
<species metaid="s1" id="s1" name="s1" compartment="default" initialAmount="0">


Note: A Complex is a type of Species but a ComplexSpeciesAlias is NOT a SpeciesAlias.
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6.3 Select Mode
After you have put a new component on Draw Area, the Select Mode icon
will automatically
be selected so that you can immediately select and move the component. This is the initial setting of
CellDesigner.
You might want to change this setting so as to create several components on Draw Area first and
then rearrange them as you like.
6.3.1

To avoid the automatic Select Mode
1. Select Edit menu in the Menu.
2. Select Input Repeat.

6.3.2

To switch temporarily to the Select Mode
3. While the Select Mode icon
is NOT selected, hold down the “s” key on your
keyboard.
4. Select a component and move it.
5. Release the “s” key to go back to the previous mode.

6.4 Select All
6.4.1

To select all the components
1. Select Edit and then Select All in the Menu
2. You can also use Ctrl-A.


Note: For Mac OS X, use Command key instead of Ctrl key.

6.5 Grouping
In Select Mode, by clicking multiple Species while holding the SHIFT key down, you can make a
temporal group of the selected Species. Moving, cutting, and copying them in a group are available.
If you want the group to be permanent (saved to SBML), use Ctrl-G while the temporary group is
formed. This grouping feature is similar to placing several Species within a Compartment but they
are different. Grouping has no effect on the structure of the model. Therefore, if these two
apparently seem to conflict each other in the Draw Area, “Species within a Compartment” structure
has priority.


6.5.1

Note: Tags cannot include in a group

To create a temporary group of components
1. Click multiple Species while holding the SHIFT key down.
2. You can move, cut or copy them together.

6.5.2

To create a permanent group of components
1. Click multiple Species while holding the SHIFT key down.
2. Select Edit and then Create Group in the Menu. Or use Ctrl-G.
3. When saved, this group information will be written in the SBML file.


Note: For Mac OS X, use Command key instead of Ctrl key.
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6.6 Alignment
6.6.1

To adjust the alignment of the components
1. Select the multiple Species you want to adjust.
2. Click Edit menu, point to Alignment, and select an alignment type.
You can also click an icon in the Toolbar.

6.6.2

To adjust the position of a component by keyboard operation
1. Select a component.
2. Use UP, DOWN, RIGHT, LEFT keys to move the component pixel by pixel.

6.7 Set Grid Snap ON/OFF
Snapping your components on the grid makes it easier to layout the pathway diagram.
6.7.1

To use Grid Snap
1. On the Edit menu, click Grid Snap.
2. To show the grid, click Grid Visible on the Edit menu.
3. To change the grid size, click Set Grid Size... on the Edit menu.

6.8 Zoom IN/OUT, Bird’s Eye View
You can change the zoom view of the model by clicking the following icons,
or use the menu [View] –[Zoom Select] to specify the zoom %.

When you create a big model, it would be convenient to use the
Bird’s Eye View to navigate inside the model.
The Bird’s Eye View can be displayed by clicking the icon
(Show Bird’s Eye View) in the above Toolbar. When you drag the red
square in the Bird’s Eye View, observe that the view of the Draw
Area moves accordingly.

6.9 Change Color and Shape
You can change the color and size of the components, such as
Species, Reactions and Compartments, individually or to
their default settings.
6.9.1

To change the default settings
1. On the Preference menu, select Components Color &
Shape....
2. In the Default Component Setting dialog, click on a
Species of which you want to change the default
settings.
3. In the Default setting of <species name> dialog,
change parameters.
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6.9.2

To change the color and shape of the individual component(s)
1. Select a component, or components of the same type.
2. In the Component menu, select Change Color & Shape..., or Click the Change Color &
Shape icon

in the tool bar.

6.10 Change Species font size
6.10.1

To change font size

1. On the Draw Area, right-click on a Species to show the context menu.
2. Select Change font ....
3. In Change Species Name Font dialog, select a font size.

6.11 Display special characters in Component name
As CellDesigner is compliant with SBML, all names of components in a model must conform to the
SBML convention. CellDesigner 4.1 is compliant with SBML Level 2 Version 1; any character that
can be mapped to UTF-8 encoding can be used for the component names. If you want the special
characters, such as + plus, line break, superscript and subscript, you should follow the special rules
to input such characters.
6.11.1

Examples

A special character is expressed by a sequence of characters with precedent and follow up '_'s. Here
are some examples:
1) Ca2+ ("Ca" with "2+" superscript)
Ca_super_2_plus__endsuper_
Ca_super_2+_endsuper_
2) G alpha beta gamma ("G" with Greek "αβγ" subscripts)
G_sub__alpha__beta__gamma__endsub_
G_sub_αβγ_endsub_
3) Complex of Cdc2 and CyclinB ("Cdc2" followed by "+CyclinB" in the new line).
Cdc2_br__plus_CyclinB
Cdc2_br_+CyclinB
For more details on displaying special characters, click Name Expression in the Help menu.


Note: CellDesigner uses the “name” attributes as information to distinguish Species. Therefore, even if the
rendered names look the same, the different “name” attributes, for example, “Gα” and “G_alpha_”, mean
different Species.
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6.12 Macros
To draw the diagram easier, some of the most frequently used components sets are available as
“macros”. You can select the macros from the tool bar to draw the following components set.

6.12.1

To view how each macro draws the components

1. In the File menu, click Open.
2. In the Open dialog, go to “samples” folder in your CellDesigner directory.
3. Double-click “Macro.xml” in the “samples” directory.

6.12.2

To change the Macro Setting

1. In the Preference menu, click Set Macro UI...
2. In the Macro UI Setting dialog, change the settings.

6.13 Automatic Layout
Automatic layout function is available for adjusting the model outlook.
When you retrieve SBML files without any layout information created by other tools, CellDesigner
will automatically adjust the layout with its layout schemes.
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6.13.1

To change the layout of your working model

1. On the Layout menu, select one of the layout types
Orthogonal Layout
Organic Layout
Smart Organic Layout
Hierarchic Layout
Incremental Hierarchic Layout
Circular Layout
Tree Layout
Edge Router

You can change the detail settings for the above types as well as default settings adopted when you
retrieve SBML files.
The default setting is Smart Organic Layout.
6.13.2

To change the Default Setting:

1. On the Layout menu, click Default Automatic Graph Layout.
2. Select a layout you want set as default.
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7. Reaction and KineticLaw
7.1 Reaction ID
7.1.1

To show Reaction ID on Draw Area
1. On the View menu, select Show Reaction ID.

with Reaction IDs

without Reaction ID

7.2 Edit a Reaction
1. Right click on a Reaction.
2. Select a menu item from the right-click context menu.

3. Select a menu item depending on which value you want to edit.
4. Selecting Change Identity will show you Change properties of the reaction dialog.

5. Selecting Edit Reaction will show you Reaction dialog.
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6. Selecting Edit KineticLaw... will show you KineticLaw dialog. See “7.4 KineticLaw“ for
detail.



See also: “Species” section of the CellDesigner.org Online Help
http://celldesigner.org/help/CDH_Species_T.html.
See also: “11 Gene / RNA / AntiSenseRNA Structure Expressions”

7.3 Reactions List
You can view all the data concerning a Reaction in the Reactions tab in the List Area. This is useful
when you want to check all the Reactions specified in the model.
You can swap columns by drag-and-drop.

You can export the contents of the list into .CSV file format by clicking Export button on the top of
the list.

7.4 KineticLaw
You can specify a KineticLaw to a Reaction using the KineticLaw dialog. You can input your own
math functions, or you can use the predefined functions from the KineticLaw dialog.
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7.4.1

To add a KineticLaw to a Reaction
1. Create a model with Proteins A and B, with a State Transition Reaction in-between.

2.
3.
4.
5.

In the List Area, click on the Species tab.
Select the row for the Protein A.
Double click on the cell under InitialQuantity column.
Set the value to “0.1”.

6. In the List Area, click on the Reactions tab and double click on the STATE_TRANSITION
Reaction to open the Reaction dialog.
7. Click KineticLaw Create button.
8. Instead of doing the steps 6 and 7, you can also click on the Reaction with the right mouse
button, and then select Edit KineticLaw... menu.

9. The KineticLaw dialog will open.

10. In the Predefined Functions pane, click Mass_Action_Kinetics.

11. The Formula dialog will be displayed.
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12. Enter “0.3” in the k text box, then click OK.
13. See that “s1*k1” has been entered in math field, then click Update, then Close.

14. In the Reaction dialog, click Close.
The KineticLaw for the Reaction was successfully set.
Now you can run the simulation.
7.4.2

To run the simulation
1. Do the previous walkthrough “To add a KineticLaw to a Reaction”. Or, just open the file
sim1.xml in the samples folder.
2. On the Simulation menu, click Control Panel.
3. In the Control Panel <filename> dialog, set End Time to “20”.
4. Click Execute button. You will obtain a graph like this.
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8. Notes and MIRIAM annotation
There are two ways to annotate a Component (Compartment, Species, or Reaction); by adding free
text Notes and by adding MIRIAM information.
The Notes allows you to enter additional text information for your Component and save it in the
xml file.


Note: Each Protein, Gene, RNAs or asRNA has a Protein/Gene/RNA/asRNA Notes as well as Species Notes.
You should be careful which Notes you want to change when editing.

The Notes should be written in XHTML format. For details on XHTML tags and attributes, please
check the XHTML 1.0 specification provided at http://www.w3.org/TR/xhtml1/
HU

U

You can enter PubMed ID in the Notes, and directly link to the relevant reference.


See also: “9 Connect to External Databases”

MIRIAM (the Minimal Information Requested In the Annotation of Models) is a standard to
annotate and curate computational models in biology. http://www.ebi.ac.uk/miriam/. SBML Level 2
Version 4 recommends using MIRIAM as an annotation scheme. CellDesigner 4.1 now supports
MIRIAM annotation.
HU

UH

MAPK42.xml is a sample file installed with CellDesigner. The file already contains MIRIAM

information to give you a picture of how MIRIAM information is added on a model.

8.1 Notes
8.1.1

To add Notes to a Component (i.e. Compartment, Species or Reaction)
1. Select a Component.
2. Click on the right mouse button to display the popup menu and select Species Notes...
(Compartment Notes... or Reaction Notes...).
3. Or, click NOTE tab in the Notes Area (at the bottom right corner of the Main Window) and
click Edit Notes button.


Note: If you select a Protein, Gene, RNA or asRNA, you will also find [Protein | Gene | RNA | asRNA] Notes
menu item in the right-click menu, as well as Edit [Protein | Gene | RNA | asRNA] Notes button in the Notes Area.
See the next procedure “To add Notes to a Protein, Gene, RNA or asRNA” on how to use them.

4. See that the Species Notes (Compartment Notes... or Reaction Notes...) dialog pops up.

5. Type the text you want to add in XHTML format.
6. Click OK to close the dialog
7. See the Notes information you have just added is displayed in the Notes Area.
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8.1.2

To add Notes to a Protein, Gene, RNA or asRNA

If your target Species is one of the following types, namely, Protein, Gene, RNA or asRNA, you can
add the [Protein | Gene | RNA | asRNA] Notes as well as the Species Notes.
1. Select a Protein, Gene, RNA or asRNA.
2. Click on the right mouse button to display the popup menu and select Edit [Protein |
Genes | RNA | asRNA] Notes, or click Edit [Protein | Genes | RNA | asRNA] Notes
button in the Notes Area (on the bottom right corner of the window).
3. [Protein | Genes | RNA | asRNA] Notes dialog pops up.

4. Type the text you want to add in XHTML format.
5. Click OK to close the dialog
6. See the Notes information you have just added is displayed in the Notes Area.

8.2 MIRIAM annotation
8.2.1

To see MIRIAM annotation on a sample file MAPK42.xml
1. In the Menu, select File, then Open.
2. In the Open dialog, find MAPK42.xml in /<your CellDesigner directory>/samples/ folder
and Click Open.
3. MAPK42.xml opens. We shall modify this file, so if you wish to keep the original file, make its
duplicate.
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4. Select a Component, e.g. Reaction “J7”.

5. In the Notes Area, click MIRIAM tab. To have a wider view, click the left-pointing arrow.

6. MIRIAM information on the Reaction “J7” is displayed.

7. Select the first row where Relation is “bqbiol:hasVersion”, DataType is “Reactome” and ID
is “REACT_2247”.

8. Click Access button, and a pop-up menu will appear.
9. In the pop-up menu, select “MIR;00100026”.
10. Your web browser will be launched and show you a Reactome web page explaining “MEK2
phosphorylates ERK-2 [Homo sapiens]”.
11. Back to CellDesigner Main Window, in the MIRIAM list, select the third row where
Relation is “bqbiol:isVersionOf”, DataType is “Enzyme Nomenclature” and ID is “2.7.12.2”.
12. Click Access button, and a pop-up menu will appear.
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13. In the pop-up menu, select one of the followings:
“MIR;00100001” to access an EBI web page
“MIR;00100002” to access a KEGG web page
“MIR;00100003” to access an ExPASy Proteomics Server web page
14. Whichever web page you go to, you will find information on Mitogen-activated protein
kinase kinase (EC 2.7.12.2).
8.2.2

To add MIRIAM information to a Component
1. On the Draw Area (Canvas), select a Component (i.e. Compartment, Species or Reaction).
2. Click on the MIRIAM tab in the Notes Area.

3. Click Add Relation button.
4. A Relation will be added to the list.

5. Click on the Relation field. Select a Relation from the pull-down menu (e.g.
“bqbiol:isVersionOf”).

6. Click on the DataType field. Select a DataType (e.g. “UniProt”).

7. Double-click on the ID field. Enter an ID (e.g. “P26696”).


Note: If you do not know the ID, click Access button. It will show MIRIAM site IDs, select one to access the
website and find the ID for the DataType.

8. Click OK to save the MIRIAM information.
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8.2.3

To add a new DataType for an existing Relation
1. Select a Component which has MIRIAM information.
2. In the Notes Area, click MIRIAM tab.
3. Select a Relation from the list.

4. Click Add DataType button.
5. A new MIRIAM entry of the same Relation will be added.

6. Click on the DataType field and select a DataType from the list.

7. Double-click on the ID field and enter an ID for the DataType.
8. Click OK to save the MIRIAM information.
8.2.4

To delete MIRIAM information
1.
2.
3.
4.


Select a Component having MIRIAM entry. of the same Relation.
In the Notes Area, click MIRIAM tab.
Select an entry to delete.
Click Remove.
Note: If you want to undo the Remove action, just click the Component on the Draw Area without clicking OK
button. MIRIAM information for the Component will not be saved until you click OK button.

5. Click OK to save the MIRIAM information.
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9. Connect to External Databases
You can connect to external databases using the Species name or ID specified in the Notes.
Currently we support the connections to the following databases.
Importing models and information
BioModels.net

http://www.biomodels.net,
http://www.ebi.ac.uk/biomodels/

JWS Online

http://jjj.biochem.sun.ac.za/

PANTHER Pathways
database

http://www.pantherdb.org/pathway/

SABIO-RK

http://sabio.villa-bosch.de/

Use Species Names for query
DBGET

http://www.genome.jp/dbget/

a simple database
retrieval system for a
diverse range of molecular
biology databases

SGD

http://yeastgenome.org/

Saacharomyces Genome
Database

iHOP

http://www.ihop-net.org/UniPub/iHOP/

Information Hyperlinked
over Proteins

Genome Network
Platform

http://genomenetwork.nig.ac.jp/public/sys/gnp
pub/portal.do

Use IDs for query
PubMed

http://www.ncbi.nlm.nih.gov/sites/entrez

*MIRIAM support

Entrez Gene

http://www.ncbi.nlm.nih.gov/sites/entrez?db=
gene

UniProt

http://www.uniprot.org

*MIRIAM support

ChEBI

http://www.ebi.ac.uk/chebi/

*MIRIAM support

MetaCyc

http://www.metacyc.org/

Gene Wiki

http://en.wikipedia.org/wiki/Portal:Gene_Wiki

Panther Web

http://www.pantherdb.org

9.1 Database Query
9.1.1

To use Species Names for database query
1. Select a component (Species, Reaction or Compartment).
2. In the Menu, select Database, and then Connect to <database name>.
3. See your web browser pop up and open the page relevant to the Species.


9.1.2

Note: In case of DBGET, search is conducted according to the format of the name. If the name is written as
“2.1.3.1”, “EC2.1.3.1”, “EC: 2.1.3.1”, and “EC 2.1.3.1” for EC number, while the name start with “C”, “C00010”,
“C 00010”, “C: 00010” , search for compound ID.

To use PubMed ID and Entrez Gene ID for database query
1. Select a component (Species, Reaction or Compartment).
2. In the Notes Area, click Edit Notes.
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3. Specify the PubMed ID / Entrez Gene ID / UniProt ID as follows:
PMID:12345
PMID:67890
GeneID: 22954
UniProtID: Q13049

4.
5.
6.
7.

In the menu bar, select Database - Connect to PubMed.
Your browser will be launched and show the PubMed web site.
In the menu bar, select Database - Connect to Entrez Gene.
Your browser will be launched and show the Entrez Gene web site.

9.2 Importing Models and Information
9.2.1

To import models from BioModels.net

BioModels Database (http://biomodels.net) is a data resource that allows biologists to store, search
and retrieve published mathematical models of biological interests. Models present in BioModels
Database are annotated and linked to relevant data resources, such as publications, databases of
compounds and pathways.
HU

UH

1. In the Menu, select Database, then Import model from BioModels.net...
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2.
3.
4.
5.


9.2.2

The BioModels.net dialog opens.
Select a model in the list and click OK.
If Notice dialog opens, just click OK.
The model will open.
Note: In step 3 above, you can also search models by name. When you put any letters or numbers to Search
box , only the models which have the letters or numbers in its name will be listed. It performs a
case-insensitive search.

To import models from pantherdb.org

Panther Pathway Database (http://www.pantherdb.org/pathway) consists of primarily signaling,
pathways, each with subfamilies and protein sequences mapped to individual pathway components.
Pathways are drawn using CellDesigner, capturing molecular level events in both signaling and
metabolic pathways, and can be exported in SBML format. The images of SBGN view of the
diagram can also be exported.
HU

HU

UH

UH

HU

UH

1.
2.
3.
4.
5.

In the Menu, select Database, then Import model from pantherdb.org...
The pantherdb.org dialog opens.
Select a model in the list and click Import.
If libSBML Consistency Check dialog opens, read the message and click OK.
If File conversion needed dialog opens, read the message and click Yes or Cancel. Even if
you click Cancel, you can still open the model.
6. If Notice dialog opens, just click OK.
7. If Compartment's size attribute is undefined. dialog opens, click OK or No. Even if you
click No, you can still open the model.
8. The model will open.
9.2.3

To import the reaction information from SABIO-RK database

The SABIO-RK (System for the Analysis of Biochemical Pathways - Reaction Kinetics) is a
web-based application based on the SABIO relational database that contains information about
biochemical reactions, their kinetic equations with their parameters, and the experimental
conditions under which these parameters were measured. It aims to support modelers in the
setting-up of models of biochemical networks, but it is also useful for experimentalists or
researchers with interest in biochemical reactions and their kinetics. Information about reactions
and their kinetics can be exported in SBML format.


See also: “7.4 KineticLaw”
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1. Import the model TCA cycle from pantherdb.org. We will use the model as a sample
throughout this walkthrough.



See also: “9.2.2 To import models from pantherdb.org”

2. On the Draw Area, select r20.

3.
4.
5.
6.
7.
8.
9.

In the Menu, select Database - Import reaction information from SABIO-RK...
The Import kineticLaw from SABIO-RK dialog will appear.
Verify that Malate Dehydrogenase is already been typed in Search query textbox.
Click Search button.
In the Confirmation dialog, click Yes.
From the returned list, select a row where id is 14888.
KineticLaws will be displayed.

10. In the Import kineticLaw from SABIO-RK dialog, click Import KineticLaw.
11. Mapping SpeciesReferences ID dialog will appear. Imported data from SABIO-RK is
displayed on the right side of the dialog.
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12. If necessary, click Swap Reactants/Products to exchange the imported Reactants and
Products.

13. Confirm that the type of each Species on the left side (CellDesigner side) meets that of the
right side (SABIO-RK side). If not, select another Species from the drop-down list.
14. Click Apply.
15. In the Confirmation dialog, read the message and click OK.
16. In the Import kineticLaw from SABIO-RK dialog, click Close.
17. On the Draw Area, right-click on the Reaction r20.
18. Select Edit KineticLaw from the list.
19. In the KineticLaw dialog, confirm that the Kinetic Law is successfully imported.
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10. Simulation
This section describes how to simulate a model.
CellDesigner can be used as an SBML file editor for simulators.
There are two ways to conduct the simulation by CellDesigner:


using Simulation menu to call SBML ODE Solvers seamlessly. The conditions can be set using
the Control Panel directly.



using SBW menu to call SBML compliant simulators.

SBW menu
to call SBML compliant simulator.

Simulation menu
for direct control over SBML ODE solvers.

If you select the Simulation menu, you can call SBML ODE solvers (SOSLib, Copasi, and
SBMLsimulator) directly. The ControlPanel enables you to specify the details of parameters, changing
amount, conducting parameter search, and interactive simulation with intuitive manner.


See also:
- SOSLib : http://www.tbi.univie.ac.at/~raim/odeSolver/
- COPASI: http://www.copasi.org
- SBMLsimulator: http://sourceforge.org/projects/sbml-simulator

If you select SBW menu, you can pass the SBML data from CellDesigner to the SBML compliant
simulators via SBW. You can conduct simulation seamlessly from CellDesigner via SBW to evoke
such SBML compliant simulators.


Note: You need to set up SBW before you conduct simulation.



See also: “1.2 Install SBW and SBW Modules”

To conduct time evolving simulation, you also need to know some basics of the SBML specification.
This section describes the minimum requirements for simulation.


Note: There are various annotated sample models at BioModels.net for simulation.



For more details on SBML specifications,
see also http://sbml.org/Documents/Specifications.
HU

U



See also: “9 Connect to External Databases”



For more details on simulations and parameter handling, see also [Running CellDesigner
Simulation with Control Panel] in ControlPanel42.pdf.

X

X

X

X
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10.1 Simulation by ControlPanel
10.1.1
1.
2.
3.
4.
5.
6.
7.

To simulate a model using the ControlPanel
Open the sample file “MAPK.xml” in the “samples” folder.
In the Menu, select Simulation - ControlPanel.
The Control Panel will open.
Select Solver of your choice: [SOSlib], [COPASI], [SBMLsim]
Change the End Time value to “1000”.
Click Execute button.
You will see the time course plot in the right side of the control panel.

See also: For more details on Control Panel, please refer to the document “Running
CellDesignerTM Simulation with Control Panel” found in the /documents folder.


10.1.2

To convert the graph to a scatter plot

1. In the ControlPanel, select any two
Species by ticking the checkboxes in
the Visible column.
2. Observe that the graph has been
reduced to two curves.
3. Tick the show scatter plot checkbox.
4. Observe that in the new graph the
x-axis does not indicate time series
any more.
5. Select the reverse checkbox to change
the x- and y- axes.

10.2 Simulation by COPASI
COPASI (http://www.copasi.org/) is a software application for simulation and analysis of
biochemical networks. You can use Copasi engine via CellDesigner’s control panel, or Copasi’s own
GUI.
HU

10.2.1

UH

To setup COPASI to use with CellDesigner

CellDesigner installer provides COPASi libraries. Users do not have to manually download and
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install COPASI library anymore.
For Windows users, please download and install “Visual Studio (C++) 2010 runtime” to use COPASI
from CellDesigner.
10.2.2

To simulate a model via CellDesigner’s Control Panel, changing the solver to COPASI

1. Click the COPASI radio button.
2. Click Execute
10.2.3
1.
2.
3.
4.

To simulate a model with COPASI
Open the sample file “MAPK.xml”.
On the Simulation menu, select COPASI GUI.
The Copasi Time Course Simulation dialog will open.
Change Duration value to “1000”.

5. Click Run.
6. In the Time Course Result window, compare the result with the section “10.1 Simulation by
ControlPanel".

10.3 Simulation by SBW modules
If you want to simulate the model with SBW modules you need to check if the SBW and
SBW-powered simulator modules are installed in the path mentioned in the section “1.2 Install SBW
and SBW Modules”.
10.3.1

To confirm the installation of SBW

1. To check if the SBW is properly installed, start CellDesigner and open a model. The SBW
menu in the main Menu should be activated if your setup has correctly been done.
2. Check if there are any simulators listed in the SBW menu.
3. If you have installed the simulators of your choice correctly, they are listed under SBW
menu.


10.3.2

Note: “Jarnac Simulation Service” appears if Jarnac has been installed. The others are default-installed.

To simulate a model using SBW component
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1. Open the sample file MAPK.xml in “samples" directory.
2. In the Menu, select SBW – Jarnac Simulation Service as an example.
This wakes Jarnac up.
3. Check the help or manual of the simulator to learn how to start the simulation.

10.4 Data required for Simulation
For simulation, you should specify at least some Species, Reactions and their attributes. The
minimum requirement of their attributes might be:
Species: -initialAmount (default=0.0),
Reaction:



10.4.1

-reactant:

-SpeciesReference:

-stoichiometry (default=1),

-product:

-SpeciesReference:

-stoichiometry (default=1),

-kineticLaw:

-math,
-parameter,

Note: the rightmost of each line is required to be input.

Species Attributes

The attribute “initialAmount” should usually be changed to a positive value.
According to SBML Level 2 specification, the attribute “math” should be a text string in which the
id of Species and the parameters are written. These attributes can be set at the Species list shown
in the List Area.
10.4.2

Reaction Attributes

The attributes and parameters of the Reaction can be specified in the Reaction dialog and their
child dialogs.
For the other parameters, the default values specified in SBML Level 2 are used.

10.5 Simulation Sample: MAPK.xml
Let us use the sample file “MAPK.xml” to see how the data required for simulation is specified in the
model.
10.5.1

To check the data required for simulation

1. Open MAPK.xml in “samples” directory.

2. Select the Species tab in the List Area and observe the initial quantities.
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3. Select the Reactions tab in the List Area to see how the kinetic laws and parameters are
specified.

4. In the Reactions list, double-click on the third row whose id is “J2”.

5. The Reaction dialog will open.

6. You can also open the Reaction dialog by clicking on the Reaction on Draw Area with the
right-mouse button, then select Edit Reaction... menu. If the Reaction ID is not displayed
on Draw Area, select View – Show Reaction Id in the Menu.
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7. Click Edit to display KineticLaw dialog.

8. In the math text box, you can change the formula.
9. In the Parameters tab, you can change the parameter values.


Note: Ticking Name checkbox will show the variables in the math text box in Species name rather than Species
ID.



Note: Ticking Math checkbox will show the variables in the math text box in fractional representation.

10.5.2

To add a Species ID in the math text box

1. In the math text box, put the cursor into the place where you want to add the Species ID.



Note: Verify that the Math checkbox is NOT selected, otherwise you cannot edit the math expression.

2. In the KineticLaw dialog, in the SelectedReaction pane, select a Species (e.g. MKK_P).
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3. Observe that the Species ID has been added.

10.5.3

To edit parameters

1. Click on the Parameters tab at the bottom of the KineticLaw dialog.
2. All the parameters related to the selected Reaction are listed.

10.5.4

To use a Predefined Function

You can use some predefined functions such as Mass Action or irreversible simple
Michaelis-Menten, by using Predefined Functions section on the dialog.
See also: “7 Reaction and KineticLaw”


10.5.5

To run the simulation

1. After checking all the reactions and KineticLaw formulas, close the KineticLaw dialog and
the Reaction dialog.
2. You can double check all the specified Reactions, Parameters, etc in the List Area.
3. Select Simulation – ControlPanel from the Menu, and then conduct the simulation.
You can view the graph as well as the simulated values in the Graph and Table tabs
respectively.
See also: “Running CellDesigner Simulation with ControlPanel” found in the documents folder.


10.5.6
1.
2.
3.
4.
5.
10.5.7

To save or print the simulated Graph
Select File – Save Image / Print menu.
Image Config Dialog will be displayed.
Click Config, and display Chart Properties dialog.
Specify Title, Legend, Plot and Other, then click OK.
Click either Save Image or Print.
To save the simulation results

1. Click SaveAs button or select File - SaveAs menu.
2. Specify where you save the results.
3. Modified model as well as the simulation results (with .sim extension) are stored in the
specified folder.

10.6 Reference: MAPK.XML
Reactions
id
J0
J1

Math
V1 * MKKK / ((1 + pow(MAPK_PP / Ki, n)) * (K1 + MKKK))
V2 * MKKK_P / (KK2 + MKKK_P)
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J2
J3
J4
J5
J6
J7
J8
J9

k3 * MKKK_P * MKK / (KK3 + MKK)
k4 * MKKK_P * MKK_P / (KK4 + MKK_P)
V5 * MKK_PP / (KK5 + MKK_PP)
V6 * MKK_P / (KK6 + MKK_P)
k7 * MKK_PP * MAPK / (KK7 + MAPK)
k8 * MKK_PP * MAPK_P / (KK8 + MAPK_P)
V9 * MAPK_PP / (KK9 + MAPK_PP)
V10 * MAPK_P / (KK10 + MAPK_P)
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Species
id
MKK
MKKK
MAPK
MKKK_P
MKK_P
MKK_PP
MAPK_P
MAPK_PP

initialQuantity
280
90
280
10
10
10
10
10

Parameters
id
V1
Ki
n
K1
V2
KK2
k3
KK3
V0
K0
k4
KK4
V5
KK5
V6
KK6
k7
KK7
k8
KK8
V9
KK9
V10
KK10

name

V0
K0

value
2.5
9
1
10
0.25
8
0.025
15
111
1
0.025
15
0.75
15
0.75
15
0.025
15
0.025
15
0.5
15
0.5
15
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10.7 MAPK42.xml
MAPK42.xml is identical to MAPK.xml except that it contains KineticLaw and MIRIAM information

displayed as layered text.



See also: “12 Layer – displaying comments over the model”
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11. Gene / RNA / AntiSenseRNA Structure Expressions
In CellDesigner 4.x, graphical notation is extended and redefined to enhance representation
capability for transcription and translation processes. The most salient feature is the capability to
describe promoter structure, and other detailed structure for genes and RNA’s.



See also: “Appendix 2: Sample Files for Graphical Notation”

11.1 Promoter Structure Representation
CellDesigner allows users to define the structure of promoter regions. Specific promoter regions are
represented on upper part of the box. When such structure information is defined, lines for both
sides and lower part of the box are either not shown or dimmed to highlight structures represented
on the upper line.
11.1.1

Symbols related to transcription and translation

11.1.2

An example of transcription related symbols
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11.1.3

To specify region symbols

1. Right-click on a Species.
2. Select Edit <Gene or RNA or asRNA>…
from the menu.
Alternatively, select the Species from the
List Area and click add button.
3. In the Modification Region dialog, select a
type from the drop-down menu and
change the size and position.
Click Close.
4. Click Update.
11.1.4

To change the modification of the
modification site of a Gene

5. Right-click on a Gene.
6. Select Change Identity… from the menu.
7. Click the target empty region and change the modification status from the drop-down
menu.

8. Click Apply.

11.2 Alternative Splicing
Alternative splicing can be represented as transition of an RNA in the original state to multiple
RNAs with different splicing patterns.

11.3 Identification of Gene, RNA, and AntiSenseRNA.
In the model, Genes, RNAs and AntiSenseRNAs are identified by their name. If the name of the
newly created component is already used in the model, the representation will become the same as
the existing one.
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12. Layer – displaying comments over the model
You can add a layer to give comments to the components and over the model. The “base” layer is the
layer where the components are displayed. Additional layers can hold free text to those components,
or draw the circle or square. You can choose to display or to hide the layers.

12.1 Add a Layer
12.1.1
1.
2.
3.
4.

To add a layer
Select Edit → Add Layer in the Menu.
LayerNameInputDialog is displayed.
Specify the Layer Name, then click Add Layer button.
In the Layer Area, find a new layer has been added to the list.

12.2 Add Text and Shapes on a Layer
12.2.1

To add a textbox to a component

1. Select a component (Species, Reaction, or Compartment).
2. In the Layer Area, select the target layer.
3. In the Menu, select Component→ Add Text.
Or, right-click on the component and select Add Text.
4. In the Input text dialog, enter any text, then press OK.
5. The text is added to the specified component.

12.2.2

To add a Layer Object onto a layer

1. In the Layer Toolbar, select an icon from the different Layer Objects.
2. Place your cursor on Draw Area, click-hold the mouse button, and drag the cursor to the
size and shape you like.
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12.2.3

To change the color and shape of a Layer Object

1. Right-click on a Layer Object to open the Change Color & Shape... dialog.
2. Change the parameters and click OK

12.3 Edit a Layer
12.3.1

To lock the Layer Objects on a layer

1. In the Layer Area, select a layer.


Note: The base layer cannot be locked, deleted nor set invisible. For it contains all the components (Species,
Reactions and Compartments) and holds no Layer Objects in it.

2. In the right-click menu, select Lock.

3. Verify that all the Layer Objects on the layer cannot be selected.
12.3.2

To set the Layer Objects invisible

1. In the Layer Area, select a layer.
2. In the right-click menu, select Invisible.
3. See that the Layer Objects belonging to the layer are invisible.
12.3.3

To delete a layer

1. In the Layer Area, select a layer.
2. In the right-click menu, select Delete Layer.
3. See that the Layer Objects belonging to the layer have been deleted.
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13. SBGN PD View
CellDesigner graphical notation can be converted to SBGN Process Description notation.
You can use the SBGN PD Viewer from CellDesigner to readily obtain an SBGN process description
graphical representation for the model created with the CellDesigner.
You can also export the graphical information in the SBGN-ML (XML exchange) format. The
SBGN-ML file format can be imported to the tools which support SBGN-ML.


Note: CellDesigner’s SBGN Viewer adopts the SBGN Process Description Diagram Level 1.1.



Note: Details for SBGN-ML format, please refer to http://sbgn.org.

13.1 Use the SBGN PD Viewer
13.1.1

To view a model with the SBGN PD Viewer

1. Open a model.
2. On the View menu, select Convert to SBGN PD view.

13.2 Difference In Graphical Notations---CellDesigner and SBGN PD Viewer
There are some differences in graphical representation between the two.
Difference in Activated State
In CellDesigner’s notation, activated proteins are surrounded by dotted line. (or open state for
Ion_channel).
In SBGN Process Description notation, activated proteins will have an oval at the bottom (States).
Protein–Generic (activated)

Protein–Ion Channel (activated)
Difference in Various Species Shapes
In SBML PD viewer, various Species shapes are represented by rounded square.
Protein –Receptor type

Protein –Truncated type

Protein –Ion_Channel type
RNA
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Antisense RNA
Gene
Difference in Notation of Clone Marker
If a Species is duplicated, both the original and the duplicates will be marked by the clone marker
(bottom part shaded).
Ion
Simple molecule
Resides/Domains etc -> Information box
Gene / RNA / asRNA with
Coding Region, Modification Site,
Transcription Starting Site,
and Regulatory Region
Difference in Notation of Transcription/Translation
Reactions of Transcription and translation are converted into the reactions with triggers.
Transcription

Translation
Difference in Association/Dissociation
In the SBGN PD Viewer, a process node is positioned near the fork.

Association

Dissociation

13.3 Show SBGN Compliants
CellDesigner has functionality that shows which parts in a model are SBGN compliant. When this
79

CellDesignerTM Startup Guide
option is enabled, parts that are not compliant are grayed out.

13.3.1

To toggle on and off the SBGN compliants option

1. Open the model.
2. Select Show SBGN Compliants from the View menu.


Note: Reactions or Species in CellDesigner that are not supported in SBGN PD will be processed as shown
below:
◦ When the “Show SBGN Compliants” option is selected: Grayed-out in CellDesigner .
◦ When the “Convert to SBGN PD View” command is selected: Removed in SBGN view.

Moreover, since Reduced Notation is not supported in SBGN PD view, it will be processed as shown
below as well.


◦ When the “Show SBGN Compliants” option is selected: Grayed-out in CellDesigner .
◦ When the “Convert to SBGN PD View” command is selected: Removed in SBGN view.

13.4 Export to SBGN-ML file format
13.4.1
1.
2.
3.
4.

To export a model to SBGN-ML format
Open a model.
On the File menu, select Export to SBGN… menu.
Specify the file name, then Save.
The file is saved with the extension of .sbgn.
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14. Limitations and Known Issues
14.1 Limitations
Available actions of UNDO and REDO are limited to actions making change on the Draw Area.

14.2 Known Issues
 The problems are reported in printing / exporting images of the huge model due to the lack of the
memory.
 When using CellDesigner in non-English environment on Mac OS X and Linux, letters on dialog
boxes from File menu are not correctly displayed.
 For Mac OS X, open “System Preferences” and click “International” icon from “Personal” row, and
then click “Language” tab. In the window for choosing language, place “English” at the top. (Note:
The terms quoted by “_” depend on your environment.) Then start CellDesigner.
 For Linux, unset LANG in the shell, then starts CellDesigner.
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Appendix 1: Symbols and Expressions
This section lists up all the symbols for building models with CellDesigner. Graphical notation and
the list of the symbols are based on the proposals by Kitano:
“Using process diagram for the graphical representation of biological networks”, Nature
Biotechnology 23(8), 961-966 (2005).
HU

UH

The symbol system for state-transition diagram and the residue state representation in these
proposals are mostly realized with CellDesigner.


See Also: http://sbgn.org for SBGN (Systems Biology Graphical Notation scheme.)
HU

UH

A sample file: Components44.xml


Note: All the graphical symbols used in CellDesingner will be found in the file “<your CellDesigner
folder>/samples/components44.xml”.

Appendix 1.1 Basic Symbols
Appendix 1.1.1 Species
There are 14 types of Species symbols.
Species

not activated

activated

Protein
-Generic
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Species

not activated

activated

Protein
-Receptor
Protein
-Ion channel
Protein
-Truncated

Complex

Gene

n/a

RNA

n/a

Anti-sense RNA

n/a

Phenotype

n/a

Ion

n/a

Simple Molecule

n/a

Drug

n/a

Unknown

n/a

Tag

Appendix 1.1.2 Modifications of Protein Residues
There are 14 types of symbols for residue modification states. The residue symbols accompanied
with their label (used for residue name and position in amino acid sequence) can be attached to all
protein-type Species.
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Modification

Symbol

Phosphorylated

Acetylated

Ubiquitinated

Methylated

Hydroxylated

Glycosylated

Myristoylated

Palmytoylated

Prenylated

Protonated

Sulfated

Empty

Unknown

Don’t Care

Appendix 1.1.3 State of Proteins
State

Symbol

Open
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Closed

User defined

Appendix 1.1.4 Modifications of Gene / RNA / AntiSenseRNA Residues
There are 5 types of symbols for residue modification states. The residue symbols accompanied with
their label (used for residue name and position in amino acid sequence) can be attached to Gene /
RNA / AntiSenseRNA.
Modification Region

Symbol

phosphorylated

acetylated

methylated

Unknown

Don’t care

Appendix 1.1.5 Compartment
There are 4 types of Compartment symbols. For each type, the thick line indicates outside of its
boundary.
Type

Symbol

Note

Square

Oval
Northwest, Northeast
Close-up type

Southwest, Southeast
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Type

Symbol

Note
West, East

Close-up type

North, South

Appendix 1.1.6 Reaction (State Transitions and others)
There are 11 symbols representing State Transitions and other types of Reactions.

Reaction
(State Transitions and others)

Symbols

Note

State Transition
Abbreviated symbol of
several Reactions

Known Transition Omitted
Unknown Transition
Transcription
Translation
Transport

Heterodimer Association

Dissociation
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Reaction
(State Transitions and others)

Symbols

Note
Dissociation of Proteins by
truncation.

Truncation

Add Reactant

Appendix 1.1.7 Reaction (Modifications)
There are 7 symbols representing Modifications.
Reaction
(Modifications)

Symbols

Catalysis

Unknown Catalysis

Inhibition

Unknown Inhibition

Physical Stimulation

Modulation

Trigger
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Appendix 1.1.8 Reaction (Logical Operations)
There are 4 symbols representing Logical Operations.
Reactions
(Logical Operations)

Symbols

Note

And

Or

Not

Unknown

Appendix 1.1.9 Reduced Notation
There are 10 symbols representing Reduced Notations..
Notation

Symbol

Positive Influence

Negative Influence

Reduced Stimulation

Reduced Modulation
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Notation

Symbol

Note

Reduced Trigger

Unknown Positive Influence

Unknown Negative Influence

Unknown Reduced Stimulation

Unknown Reduced Modulation

Unknown Reduced Trigger

Appendix 1.2 Expressions
Here are symbols acquiring additional semantics by shape, combination of symbols, or change in
drawings.

Expression

Symbol

Note
Select a Protein and, in the
Component menu, select Set
Active.

Active

Select an Ion Channel and, in
the Component menu, select Set
Active.

Channel Open

Species State
Open / Closed
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Expression

Symbol

Note

Double-click the Species to
open the identity dialog, then
set the Homodimer number.

Homodimer formed

Set Change Complex View to
normal / compact / no border.
compact is used to hide the
contents of the Complex.

Complex

no border is mainly used for a
Complex with Genes etc.
Complex in a Complex

Hypothetical Species

Double-click the Species to
open the Change identity of the
species dialog, then select
hypothetical.

Reversible Reactions

Double-click the Reaction, then
set Reversible to True.

Bidirectional Reactions

Simply draw two state
transitions and reposition
them.

Homodimer Formation

Click the icon of Homodimer
Formation.

Degradation of Species

Click the icon of Degradation.
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Appendix 2: Sample Files for Graphical Notation
To explore new graphical notation scheme, there are sample files available in this version. Please
open the files in the /samples directory and try editing the model.

Appendix 2.1 Examples of the sample files contained in the CellDesigner
/samples/database44.xml

/samples/M-Phase.xml

/samples/M-Phase2.xml
/samples/MAPK42.xml

/samples/sim2.xml
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/samples/Macros.xml

/samples/SBGNRefCard.xml

/samples/UnitOfInformation.xml

/samples/notation/geneRNA44.xml

/samples/notation/ReactionShape.xml

/samples/notation/Complex44.xml

Appendix 2.2 Examples for Graphical Notation
These are the examples used in the paper
“The Process Diagram for Graphical Representation of Biological Networks,” Kitano, H. et al.
Nature Biotechnology, August 2005.
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Fig1b_ProcessDiagram_4

Fig3abcd_AndOr_4

Fig3e_EGFR_league_4

SuplFig2_GPCR beta2-AR_4

SuplFig3_NF-kappaB(p65+p50)_4

SuplFig4a_TranscriptionTranslation SuplFig4b_transcription_4
_4
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SuplFig5_StructureofComplex_4

SuplFig7_M-Phase_4

Appendix 2.3 CellDesigner Species / Reactions Conventions
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